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Представлены описания двух лабораторных работ, охватывающих ос-
новные этапы проектирования электронных систем на базе цифрового сиг-
нального процессора фирмы Texas Instruments Incorporated TMS320DM642 
(семейство C6000). При выполнении лабораторных работ предусмотрено 
использование различных лабораторных установок, выпускаемых фирмой 
Spectrum Digital Incorporated (США), например TMS320DM642 Evaluation 
Module (DM642EVM), а также разработанных и изготавливаемых научно-
производственной фирмой «Сигма-ИС» (г. Москва).

Предназначены для студентов 5-го курса специальностей 210201 – 
проектирование и технология радиоэлектронных средств, 210202 – проек-
тирование и технология электронно-вычислительных средств, а также для 
магистрантов 2-го курса, обучающихся по направлению 210200 – проекти-
рование и технология электронных средств очной формы обучения.

Табл. 1. Ил. 8. Библиогр.: 5 назв.
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ВВЕДЕНИЕ
Лабораторные занятия по дисциплинам «Сигнальные процессо-

ры», «Основы проектирования электронных средств» и «Проектиро-
вание электронно-вычислительных средств специального назначе-
ния» имеют своей целью помочь студентам закрепить теоретические 
знания, полученные при изучении лекционных курсов, и приобрести 
необходимые практические навыки проектирования электронных циф-
ровых систем, способных обрабатывать данные в режиме реального 
времени. Во многих случаях при реализации математически сложных 
алгоритмов применяют цифровые сигнальные процессоры (ЦСП, 
Digital Signal Processors, DSP) [1], которые обеспечивают высокую про-
изводительность вычислений, позволяя тем самым достичь режима ре-
ального времени при обработке даже очень больших объемов данных. 
Указанные вычислительные устройства с успехом используются в те-
лекоммуникационных сетях, а также в системах цифрового телевиде-
ния и радиовещания, т. е. в тех областях, значение которых возрастает 
с каждым днем. Кроме того, ЦСП подходят для решения специальных 
задач, связанных, например, с распознаванием образов и навигацией.

В настоящее время на рынке ЦСП представлено множество 
фирм, но лишь четыре из них являются признанными мировыми 
лидерами в данной области: Texas Instruments Inc., изготовившая 
в 1982 г. процессор TMS320C10, который открыл эру коммерчес-
ких ЦСП; Analog Devices Inc., Motorola Inc., Lucent Technologies 
(AT&T), разрабатывающая и производящая ЦСП преимущественно 
для телекоммуникационных систем.

Наибольший сегмент рынка ЦСП как в России, так и за рубе-
жом принадлежит продукции фирмы Texas Instruments. Именно 
поэтому настоящие методические указания посвящены изучению 
процессоров семейства TMS320C6000, которое обеспечивает на-
ибольшую производительность среди всей линейки ЦСП фирмы 
Texas Instruments.

При выполнении лабораторных работ от студентов требуются 
навыки программирования с использованием языков низкого (ас-
семблер) и высокого уровня (C/C++), полученные в ходе изучения 
дисциплины «Информатика», а также знание основ цифровой схе-
мотехники. Методические указания могут быть полезны студентам 
при курсовом и дипломном проектировании.
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Лабораторная работа № 1 
ИССЛЕДОВАНИЕ И СРАВНИТЕЛЬНЫЙ АНАЛИЗ 

ЛАБОРАТОРНЫХ УСТАНОВОК
Цель работы – исследование, изучение и сравнение схемотех-

нических, а также конструкторских решений, используемых как в 
лабораторных стендах, так и в серийно выпускаемых изделиях, пос-
троенных на основе ЦСП TMS320DM642 фирмы Texas Instruments.

1. Основные положения
Настоящие лабораторные работы посвящены изучению ЦСП 

TMS320DM642 фирмы Texas Instruments, который относится к се-
мейству TMS320C6000 и построен по технологии DaVinci. Лабо-
раторные работы рассчитаны на использование оборудования, вы-
пускаемого ведущими отечественными и зарубежными фирмами, 
специализирующимися в области цифровой обработки сигналов:

- лабораторного стенда TMS320DM642 Evaluation Module [2] 
(DM642EVM, фирма «Spectrum Digital Inc.», г. Стаффорд, США, 
рис. 1, таблица);

- лабораторного стенда RMVideo-EVM [3] (отладочный ком-
плект для систем цифровой обработки мультимедийных данных, 
разработанный и производимый фирмой «Сигма-ИС», г. Москва,  
рис. 2, см. таблицу);

Рис. 1. Общий вид лабораторного стенда DM642EVM
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- модулей цифровой обработки мультимедийных данных 
RMVideo-04-100 [3] (рис. 3, см. таблицу) или RMVideo-06-150 [3] 
(рис. 4, см. таблицу), серийно изготавливаемых фирмой «Сигма-ИС».

Рис. 2. Общий вид лабораторного стенда RMVideo-EVM

Рис. 3. Общий вид модуля RMVideo-04-100
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Сравнение технических характеристик плат DM642EVM, 
RMVideo-EVM, RMVideo-04-100 и RMVideo-06-150

Характе-
ристика

Название лабораторной установки

DM642EVM RMVideo-EVM RMVideo-04-100 RMVideo-06-150

Тактовая 
частота ЦСП, 

МГц
720 600������   ����� / ���720 600 720

ПЛИС XC2S300 
(Spartan)

EP2C8
(Cyclone II) - -

ОЗУ
32 Мбайта 
(256 Мбит, 
2Mх32x4)

32 Мбайта 
(256 Мбит, 
2Mх32x4)

32 Мбайта 
(256 Мбит, 
2Mх32x4)

64 Мбайта (512 
Мбит, 4Mх32x4)

АЦП 
видеоданных

TVP5416, 
TVP5150A 4xSAA7113 4xSAA7113 / 

TVP5154
6xSAA7113 / 

TVP5154

ЦАП 
видеоданных SAA7105 SAA7121 - -

Энерго-
независимая 
флэш-память

AM29LV033C
(4 Мбайта)

AT45DB081B
(4 Мбайта) - -

Коммуника-
ционные 

интерфейсы

PCI 33/66 ���МГц, 
Ethernet 10/ 
100 ������Мбит��,  

RS-232

PCI 33/66 ���МГц, 
Ethernet 10/ 
100 Мбит, 

IDE (PATA)

PCI 33/66 МГц PCI 33/66 МГц

Лабораторные установки DM642EVM и RMVideo-EVM пред-
ставляют собой интегрированную платформу для оценки техничес-
ких характеристик и возможностей ЦСП TMS320DM642 фирмы 
Texas Instruments, а также других электронных узлов и компонен-
тов, расположенных на платах (например ПЛИС, АЦП и ЦАП ви-
део- и аудиоданных).

Модули цифровой обработки мультимедийных данных 
RMVideo-04-100 и RMVideo-06-150 – серийно выпускаемые изде-
лия, которые применяются в системах охранного телевидения, пе-
редачи видео- и аудиоданных по локальным и глобальным сетям, 
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а также во многих других приложениях. Данные модули в отличие 
от лабораторных стендов DM642EVM и RMVideo-EVM содержат 
минимальный набор периферийных устройств, что, безусловно, 
сказывается на схемотехнических и конструктивных особенностях 
данных плат. Модули RMVideo-04-100 и RMVideo-06-150 использу-
ются с целью демонстрации студентам различия между макетными 
устройствами и серийно изготавливаемой продукцией.

Для выполнения данных лабораторных работ был разработан 
аппаратно-программный комплекс (АПК), состоящий из трех базо-
вых компонентов (рис. 5):

– персонального компьютера (ПК);
– лабораторного стенда (ЛС), в качестве которого могут ис-

пользоваться DM642EVM, RMVideo-EVM, RMVideo-04-100 и 
RMVideo-06-150 и который может функционировать в одном из 
двух режимов – в режиме PCI-карты (при этом ЛС устанавлива-
ется в PCI-слот, расположенный на системной плате ПК) или авто-
номном режиме (в этом случае ЛС размещается непосредственно на 
столе, рядом с системным блоком ПК);

Рис. 4. Общий вид модуля RMVideo-06-150
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– эмулятора-программатора (ЭП), подключаемого с одной 
стороны к ПК по одному из стандартных интерфейсов (например 
USB или PCI), а с другой – к ЛС через интерфейс JTAG.

В качестве ПК может использоваться любой IBM PC AT/XT 
совместимый компьютер с установленной операционной системой 
WINDOWS 2000, WINDOWS XP или выше. Как эмулятор-програм-
матор для вышеперечисленных ЛС может выступать любой эмуля-
тор, реализующий спецификацию XDS510 или XDS560, разрабо-
танную фирмой Texas Instruments. Данный АПК предназначен: 

- для изучения типовых схемотехнических и конструкторских ре-
шений, в основе которых лежат ЦСП TMS320DM642 и ряд перифе-
рийных узлов (таких как ПЛИС, АПЦ/ЦАП видео- и аудиоданных);

- разработки встраиваемого программного обеспечения (ВПО) 
под указанный процессор и конфигурационных файлов для ПЛИС. 

При выполнении лабораторных работ ЛС DM642EVM использует-
ся как базовый, поскольку он обладает расширенным набором перифе-

Рис. 5. Общий вид АПК для исследования ЦСП TMS320DM642
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рийных модулей различного типа. В этой связи необходимо подробно 
рассмотреть состав и структуру DM642EVM. Как видно из табл. 1 и 
рис. 6, данный ЛС состоит из следующих базовых узлов [2]:

- модуля ЦСП («DM642»);
- модуля ПЛИС («OSD FPGA»);
- модуля 64-разрядного ОЗУ, включающего в себя две микросхе-

мы 32-разрядной синхронной динамической памяти («SDRAM»);
- модуля энергонезависимой флэш-памяти общего назначения 

(«Flash»); в ней могут, например, храниться конфигурационные 
файлы для ЦСП;

- двухпортового модуля универсального асинхронного прием-
ника/передатчика («Dual UART»); первый порт – «RS-232 Port A», 
второй порт – «RS-232 Port B»;

- модуля Ethernet PHY («ENET PHY»), который выполняет фун-
кции физического уровня в соответствии с моделью OSI (EMAC-
контроллер встроен непосредственно в ЦСП TMS320DM642);

- модуля АЦП/ЦАП аудиоданных («AIC23 Codec»), позволя-
ющего преобразовывать аналоговый сигнал в цифровую форму и 
обратно, а также выполнять другие функции (например при работе 
с телефонной линией); для ввода сигнала в модуль АЦП/ЦАП ау-
диоданных используются интерфейсы «MIC IN», «LINE IN», а для 
вывода – «LINE OUT» и «S/PDIF»;

- модуля АЦП видеоданных № 1 («Video Decoder 1»), позволя-
ющего декодировать телевизионные сигналы, соответствующие 
стандартам PAL/NTSC/SECAM (т. е. производить преобразование 
аналогового видеосигнала в цифровой формат) [4]; для ввода сиг-
нала в модуль АЦП видеоданных № 1 используются интерфейсы  
«Comp IN 1» и «SVHS IN 1»;

- модуля АЦП видеоданных № 2 («Video Decoder 2»), который в 
целом функционирует аналогично модулю АЦП видеоданных № 1, 
однако имеются отличия в технических характеристиках (см. [4]); 
для ввода сигнала в модуль АЦП видеоданных № 2 используются 
интерфейсы «Comp IN 1» и «Comp IN 2»;

- модуля ЦАП видеоданных («Video Encoder»), который позволя-
ет формировать видеосигналы различных форматов (например VGA 
и композитный сигнал стандартов PAL/NTSC/SECAM) и выводить 
их с использованием различных интерфейсов («SVHS OUT», «Red 
Output», «Green Output», «Blue Output», «VGA / RGB Output») [5];
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- модуля энергонезависимой EEPROM-памяти общего назначе-
ния («I2C EEPROM»); в качестве интерфейса взаимодействия с ЦСП 
используется шина I2C, что обусловливает низкую скорость обмена 
данными;

- модуля энергонезависимой памяти («PCI Config»), в кото-
рой хранятся настройки PCI-контроллера, встроенного в ЦСП 
TMS320DM642;

- светодиодов общего назначения («LEDs»); их функции могут 
быть запрограммированы пользователем;

- модуля JTAG («JTAG»), предназначенного для программиро-
вания и тестирования ЦСП;

- модуля PCI («PCI/HPI»), включающего в себя PCI-разъем, дву-
направленные буферы и PCI-контроллер, встроенный в ЦСП;

- модуля питания («PWR»), генерирующего три номинала ста-
билизированных напряжений питания (1,4; 1,8 и 3,3 В).

Примечание. При начале работы с АПК следует быть внима-
тельным и соблюдать особую осторожность, поскольку неверный 
порядок подключения и запуска может привести к повреждению 
одного или нескольких компонентов комплекса.

При включении АПК необходимо придерживаться следующего 
порядка действий:

1)	 выключить ПК, если он был включен;
2)	 подключить ЭП с одной стороны к ПК, а с другой – к соответс-

твующему разъему JTAG ЛС (разъемы J6 или J7 ЛС DM642EVM);
3)	 подключить блок питания к ЛС (приложение);
4)	 включить ПК.
Порядок подключения ЭП к ПК определяется типом интер-

фейса данного устройства (PCI или USB). Подробную информа-
цию о подключении ЭП можно найти в технической документа-
ции на него. Основные сведения о ЛС DM642EVM представлены в 
приложении. Подробную информацию о ЛС DM642EVM, а также 
его схему электрическую принципиальную и перечень элементов 
можно найти в [2] и на компакт-диске, поставляемом вместе с дан-
ным ЛС.
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2. Выполнение работы
Задание на подготовку к работе
Перед выполнением лабораторной работы студент должен:
1) изучить технические характеристики ЦСП семейства 

TMS320C6000, в частности процессоры, построенные по техноло-
гии DaVinci, включая ЦСП TMS320DM642;

2) ознакомиться с техническими характеристиками ЛС DM642EVM, 
RMVideo-EVM, RMVideo-04-100 и RMVideo-06-150;

3) изучить требования по технике безопасности при работе с 
ПК, а также порядок включения и запуска АПК.

Используемое оборудование
1. ПК с установленной на него операционной системой 

Windows 2000 или Windows XP.
2. ЛС DM642EVM, RMVideo-EVM, RMVideo-04-100 и 

RMVideo-06-150.
3. ЭП и компакт-диск с программным обеспечением.

Лабораторное задание
1. Подготовить АПК к работе.
2. Описать работу одного из узлов ЛС, указанного преподава-

телем.
3. Провести сравнение схемотехнических и конструкторских 

решений, применяемых в четырех рассматриваемых ЛС.

Порядок выполнения работы
1. Проверить работоспособность ПК.
2. Подключить все элементы АПК друг к другу и включить его.
3. Установить среду программирования Code Composer Studio 3.3.
4. Установить драйверы для обеспечения работы ЭП.
5. Настроить среду программирования Code Composer Studio 3.3 

для работы с установленным эмулятором-программатором.

3. Содержание отчета
1. Цель работы.
2. Описание лабораторных стендов DM642EVM, RMVideo-EVM, 

RMVideo-04-100 и RMVideo-06-150.
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3. Схемы электрическая структурная и электрическая функ-
циональная лабораторных стендов DM642EVM, RMVideo-EVM, 
RMVideo-04-100 и RMVideo-06-150, выполненные в соответствии 
с ЕСКД.

4. Лабораторное задание, выданное преподавателем.
5. Порядок выполнения лабораторного задания.
6. Описание методики установки ЭП и его драйверов на ПК под 

операционную систему Windows 2000 или Windows XP.
7. Порядок настройки среды программирования Code Composer 

Studio 3.3 для работы с установленным эмулятором-программатором.
8. Описание одного из узлов ЛС, указанного в лабораторном 

задании.
9. Выводы по лабораторной работе.

4. Контрольные вопросы
1. Какие стенды используются при выполнении лабораторных 

работ? Чем они отличаются друг от друга? Проведите сравнение ла-
бораторных стендов по их техническим характеристикам.

2. Дайте краткую характеристику семейству ЦСП TMS320С6000 
фирмы Texas Instruments. Каковы области его применения? В чем 
его преимущества по сравнению с близкими семействами других 
фирм-производителей? В чем заключаются его недостатки?

3. Дайте краткую характеристику ЦСП TMS320DM642 фир-
мы Texas Instruments? Для решения какого класса задач был раз-
работан данный ЦСП? Сравните его с другими ЦСП фирмы Texas 
Instruments, построенными по технологии DaVinci.

4. Из каких основных элементов состоит АПК? Каково их фун-
кциональное назначение? Кратко опишите каждый из элементов. В 
каких режимах может функционировать ЛС? Чем они отличаются 
друг от друга?

5. Опишите порядок включения АПК и подачи питания на ЛС 
DM642EVM. Какие меры предосторожности должны соблюдаться 
при подключении элементов АПК? Как можно перезагрузить ЛС 
DM642EVM?

6. Какими встроенными устройствами ввода-вывода обладает 
ЛС DM642EVM? Какие интерфейсы могут использоваться для свя-
зи ЛС с ПК? В чем преимущества и недостатки каждого варианта? 
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7. Какое программное обеспечение необходимо для функциони-
рования АПК? Опишите порядок его установки на ПК.

8. Опишите функциональное назначение узла ЛС, указанного 
преподавателем. Объясните по схеме электрической принципиаль-
ной ЛС его работу.

Лабораторная работа № 2 
ИЗУЧЕНИЕ МЕТОДИКИ РАЗРАБОТКИ 

ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ  
В СРЕДЕ CODE COMPOSER STUDIO 3.3

Цель работы – исследование функциональных возможнос-
тей среды программирования Code Composer Studio 3.3, изучение 
основных этапов разработки программного обеспечения под опе-
рационную систему реального времени DSP/BIOS и получение 
практических навыков работы с ЦСП TMS320DM642 фирмы Texas 
Instruments.

1. Основные положения
Использование ЦСП тесно связано с разработкой системного и 

прикладного программного обеспечения, поэтому опыт и практи-
ческие навыки работы в среде программирования ЦСП во многом 
определяют длительность проекта в целом. В качестве среды про-
граммирования ЦСП фирмы Texas Instruments используется интег-
рированная среда разработки (Integrated Development Environment, 
IDE) Code Composer Studio 3.3 (CCS3.3). Она обладает полным на-
бором инструментов для разработки и отладки программного обес-
печения для ЦСП фирмы Texas Instruments. В рамках настоящей 
лабораторной работы студенты должны изучить базовые функци-
ональные модули, входящие в состав данной среды программиро-
вания, а также освоить методику разработки программного обес-
печения под операционную систему реального времени DSP/BIOS, 
применяемую в ЦСП фирмы Texas Instruments. Первый шаг при раз-
работке программного обеспечения –  создание проекта в CCS3.3 
(рис. 7), для этого необходимо выполнить следующую последова-
тельность действий [4].
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1.	 Нажмите на кнопку Пуск и зайдите в пункт меню Все про-
граммы→Texas Instruments→Code Composer Studio 3.3→Code 
Composer Studio или дважды щелкните на ярлычке CCStudio v.3.3, 
который создается на рабочем столе автоматически при установке 
Code Composer Studio 3.3.

2.	 Зайдите в меню Project и выберите пункт New…, откроется 
диалоговое окно Project Creation (рис. 8).

Рис. 7. Общий вид среды программирования ������CCS���3.3

Рис�� ��� �������������������  �������� �����. 8. �������������������  �������� �����Диалоговое���������  �������� ����� �������� �������� �����окно���� �������� ����� Project Creation
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3.	 В поле Project Name напишите название проекта (например 
MyFirstProject).

4.	 В поле Location укажите свой рабочий каталог (по умолча-
нию C:\CCStudio_v3.3\myprojects).

5.	 В поле Project Type выберите Executable (.out).
6.	 В поле Target выберите семейство, к которому относится 

ЦСП, используемый в проекте (в случае ЦСП TMS320DM642 вы-
бираем семейство TMS320C64XX).

7.	П осле того как все поля в диалоговом окне Project Creation 
(см. рис. 8) будут заполнены, нажмите на кнопку Finish.

Когда проект будет создан, скопируйте в каталог проекта содер-
жание директории MyFirstProject, расположенной в корневом ката-
логе компакт-диска, выданного преподавателем. Затем необходимо 
добавить скопированные файлы в состав проекта. Для этого выпол-
ните следующую последовательность действий [4].

1.	 Зайдите в меню Project и выберите пункт Add Files to 
Project…, откроется диалоговое окно Add Files to Project. Открыть 
это же диалоговое окно можно нажав правой клавишей мыши на 
значке созданного вами проекта в окне Project View и выбрав пункт 
Add Files to Project… из выпадающего меню.

2.	 Выберите пункт Asm Source Files (*.a*) в выпадающем 
списке с названием Тип файлов (Files of type), затем выделите фай-
лы vectors.asm и load.asm, нажмите на кнопку Открыть (Open).

3.	 Снова откройте диалоговое окно Add Files to Project, как 
сказано в п. 1. Выберите пункт Linker Command File (*.cmd, *.lcf) 
в выпадающем списке с названием Тип файлов (Files of type), затем 
выделите файл volume.cmd, нажмите на кнопку Открыть (Open).

4.	 Выберите Project→Add Files to Project и пункт Object and 
Library Files (*.o*, *.l) в выпадающем списке с названием Тип фай-
лов (Files of type), затем в поле Имя файла (File Name) введите 
строку C:\CCStudio_v3.3\c6000\cgtools\lib\rts6400.lib и нажмите на 
кнопку Открыть (Open).

Чтобы увидеть содержимое созданного вами проекта, необхо-
димо нажать на значок «+» рядом с пунктом Projects в окне Project 
View – вы увидите перечень всех открытых проектов. Затем нажми-
те на значок «+» рядом с названием соответствующего проекта (на-
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пример MyFirstProject.pjt) – раскроется структура проекта, состо-
ящая из набора папок:

- Dependent Projects – перечень связанных проектов;
- Documents – перечень документов, относящихся к данному 

проекту; 
- DSP/BIOS – перечень файлов, в которых содержатся настрой-

ки операционной системы DSP/BIOS, используемой в ЦСП фирмы 
Texas Instruments Inc.; 

- Generated Files – файлы, полученные в процессе компиляции; 
- Include – заголовочные файлы (так называемые h-файлы, или 

header-файлы); 
- Libraries – перечень подключенных библиотек;
- Source – перечень исходных файлов (c-, cpp-, asm-файлы).
Раскрыть каждую из папок можно нажав на значке «+» рядом с 

названием соответствующей папки.
После того как все необходимые файлы будут добавлены, наведи-

те указатель мыши на название проекта (например MyFirstProject) 
в окне Project View. В выпадающем меню выберите пункт Scan All 
File Dependencies для того, чтобы обновить дерево зависимостей 
(dependency tree). Следующий шаг – компиляция проекта, которую 
можно осуществить несколькими способами:

1)	 компилировать каждый файл отдельно (используя пункт 
меню Project→Compile File или соответствующий значок), а затем 
делать их сборку (linking) для получения одного out-файла;

2)	 компилировать проект целиком (используя пункт меню 
Project→Rebuild All или соответствующий значок);

3)	 если проект был скопирован ранее, но в него затем были 
внесены изменения, то можно использовать процедуру инкремент-
ной компиляции (выбрав пункт меню Project→Build или соответс-
твующий значок).

Следующий после компиляции шаг – загрузка сгенерированно-
го out-файла в оперативную память ЦСП. Для этого нужно выбрать 
пункт меню File→Load Program… или воспользоваться сочетани-
ем клавиш Ctrl+L. В открывшемся диалоговом окне выберите соот-
ветствующий out-файл и нажмите на кнопку Открыть (Open) – на-
чнется процесс загрузки. Для того чтобы начать процесс отладки 
проекта с функции main, выберите пункт меню Debug→Go Main 
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или воспользуйтесь сочетанием клавиш Ctrl+M. Точка, с которой 
начнется выполнение программы, будет указана стрелкой желто-
го цвета. Запуск программы осуществляется путем выбора пункта 
меню Debug→Run, нажатия на клавишу F5 или соответствующий 
значок на панели инструментов. Для остановки программы следует 
выбрать пункта меню Debug→Halt, нажать на клавиши Shift+F5 
или соответствующий значок на панели инструментов.

Интегрированная среда разработки Code Composer Studio 3.3 
поддерживает все типовые средства отладки, такие как точки 
прерывания (Breakpoint), окна просмотра значений переменных 
(Watch), пошаговую трассировку программы и пр. Другой важный 
инструмент, входящий в состав пакета CCS3.3 и существенно об-
легчающий работу программиста над проектом, – операционная 
система реального времени DSP/BIOS. Она обладает масштабируе-
мым ядром и разработана специально для приложений, требующих 
синхронизации и диспетчеризации задач в реальном времени, а 
также для взаимодействия ЦСП с другими процессорами (напри-
мер соединений типа «host-to-target») [4]. Операционная система 
DSP/BIOS поддерживает многозадачные приложения (каждая из 
задач обладает разным приоритетом, который может изменяться 
в процессе ее выполнения) и способна проводить анализ данных 
в режиме реального времени (например Real-Time Data eXchange 
RTDX) [4]. DSP/BIOS построена как набор модулей, которые мо-
гут использоваться отдельно, т. е. в приложение включаются только 
те модули операционной системы DSP/BIOS, которые были явным 
или неявным образом в нем указаны [4]. Это позволяет оптимизиро-
вать размер кода и время его выполнения посредством разрешения 
или запрещения включать в него отдельные модули DSP/BIOS [4]. 
Операционная система реального времени DSP/BIOS состоит из 
компонентов [4]:

- DSP/BIOS Configuration Tool (конфигуратор DSP/BIOS), кото-
рый позволяет создавать объекты DSP/BIOS и менять их свойства;

- DSP/BIOS Real-time Analysis Tools (анализатор реального вре-
мени), необходимый для анализа процессов, происходящих в про-
грамме;

- DSP/BIOS API (набор функций DSP/BIOS), который включает 
в себя более 150 функций.
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2. Выполнение работы
Задание на подготовку к работе
Перед выполнением лабораторной работы студент должен:
1) изучить основные функциональные возможности среды про-

граммирования Code Composer Studio 3.3;
2) ознакомиться с техническими характеристиками операцион-

ной системы реального времени DSP/BIOS;
3) изучить методику разработки программного обеспечения для 

ЦСП в среде CCS3.3 под операционную систему реального времени 
DSP/BIOS.

Используемое оборудование
1. ПК с заранее установленными на него операционной систе-

мой Windows 2000 или Windows XP, а также средой программиро-
вания CCS3.3.

2. Лабораторный стенд DM642EVM.
3. XDS510- или XDS560-совместимый эмулятор-программатор.

Лабораторное задание
1. Подготовить АПК к работе.
2. Реализовать на базе ЛС DM642EVM указанный преподава-

телем алгоритм цифровой обработки видео- или аудиосигнала, ис-
пользуя языки верхнего (C/C++) и низкого (ассемблер) уровней, а 
также средства операционной системы DSP/BIOS (в частности се-
мафоры и очереди).

3. Продемонстрировать результаты работы реализованного ал-
горитма, используя интегрированные на ЛС DM642EVM устройс-
тва вывода данных.

Порядок выполнения работы
1. Проверить работоспособность АПК.
2. Загрузить ПК и среду программирования Code Composer 

Studio 3.3.
3. Разработать и скомпилировать проект в соответствии с зада-

нием, полученным от преподавателя.
4. Отладить проект на базе ЛС DM642EVM, используя для это-

го ЭП.
5. Продемонстрировать результаты работы проекта преподавателю.
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3. Содержание отчета
1. Цель работы.
2. Описание методики разработки программного обеспечения в 

среде CCS3.3 с использованием операционной системы DSP/BIOS.
3. Схема электрическая структурная АПК.
4. Лабораторное задание, выданное преподавателем.
5. Порядок выполнения лабораторного задания.
6. Блок-схема алгоритма, выданного преподавателем.
7. Описание структуры проекта и результатов работы.
8. Выводы по лабораторной работе.
9. Листинг всех файлов, входящих в проект.

4. Контрольные вопросы
1. Перечислите основные функциональные возможности среды 

программирования Code Composer Studio 3.3. Проведите сравнение 
данной среды программирования с другими вам известными средами.

2. Опишите процедуры создания, компиляции, загрузки и от-
ладки нового проекта в среде CCS3.3. Как можно добавить новые 
файлы в проект?

3. Дайте краткую характеристику и опишите архитектуру опе-
рационной системы реального времени DSP/BIOS. Из каких базо-
вых элементов она состоит? Для чего она предназначена?

4. Из каких модулей состоит операционная система реального 
времени DSP/BIOS? Опишите их функциональное назначение.

5. Что такое «многозадачность» и «многопоточность»? Как ре-
ализуются эти режимы в операционной системе реального времени 
DSP/BIOS?

6. Перечислите и опишите инструменты анализа процессов. 
Для чего они предназначены и чем отличаются друг от друга?

7. Что такое семафоры и очереди? Для чего они нужны и в ка-
ких случаях применяются? Какие функции операционной системы 
DSP/BIOS требуются при их программной реализации?

8. Что такое RTDX? Для каких целей он используется?
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ЗАКЛЮЧЕНИЕ
Настоящее издание посвящено перспективной элементной базе, 

широко используемой в современной электронике и вычислитель-
ной технике, – цифровым сигнальным процессорам. Оно предна-
значено для получения базовых знаний по ЦСП семейства С6000 
фирмы Texas Instruments, поэтому навыки, полученные в ходе вы-
полнения лабораторных работ, можно считать лишь начальным 
уровнем подготовки в области проектирования электронных систем 
на основе ЦСП.

Центральная идея данных методических указаний – последо-
вательное изучение студентами основных этапов проектирования 
электронных систем на основе ЦСП, начиная с анализа схемы элек-
трической принципиальной и конструкции устройства и заканчивая 
разработкой встраиваемого программного обеспечения под ЦСП. 
Такой подход к построению занятий помогает студентам лучше по-
нять процесс проектирования – они смогут его оценить как после-
довательность тесно взаимосвязанных этапов, а не как набор раз-
розненных процедур.

Следует отметить, что проектирование электронных систем 
на основе ЦСП требует большого объема теоретических знаний и 
серьезной практической подготовки как в области схемотехники и 
конструирования электронных средств, так и в области программи-
рования. В этой связи целесообразно перечислить тематики, знание 
которых необходимо при проектировании сложных систем на базе 
ЦСП и которые требуют отдельного глубокого изучения:

- архитектура цифровых сигнальных процессоров;
- архитектура современных операционных систем реального 

времени;
- разработка многопоточных и многозадачных приложений;
- схемотехника смешанных (цифроаналоговых) схем, вклю-

чая знания по сетям (в первую очередь Ethernet, FastEthernet, 
GigabitEthernet) и локальным шинам (PCI, PCI-Express, I2C и т. д.);

- современные сетевые протоколы.
Знания, полученные студентами в ходе выполнения лаборатор-

ных работ, могут быть использованы ими при курсовом и диплом-
ном проектировании.
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Таблица П1
Разъемы, размещенные на ЛС DM642EVM [2]

Условное  
обозначение  
(см. рисунок)

Количество 
выводов Описание

J1 4 S-Video-выход
J2 2 Видеовыход – красная компонента
J3 2 Видеовыход – зеленая компонента
J4 2 Видеовыход – синяя компонента
J5 15 VGA-видеовыход
J6 6 JTAG-разъем для ПЛИС XC2S300E
J7 13 JTAG-разъем для ЦСП TMS320DM642
J8 8 RJ-45-разъем для сети Fast Ethernet
J9 3 SPDIF-аудиовыход (RCA-разъем)
J10 2 Разъем питания (+5 В)
J11 9 DB-9-разъем для интерфейса RS-232
J12 10 PLD-10-разъем для интерфейса RS-232
J13 2 Микрофонный или линейный аудиовход
J14 2 Линейный аудиовыход
J15 2 Композитный видеовход
J16 4 S-Video-вход
J17 2 Композитный видеовход
J18 2 Композитный видеовход
J19 60 60-выводный разъем для подключения эму-

лятора (размещается на нижней стороне 
стенда)

DC_P1 90 90-контактный разъем, на который выведены 
сигналы с порта 2 для приема/передачи циф-
ровых видеоданных и ряд других сигналов 
(например выводы общего назначения и входы 
и выходы таймеров ЦСП TMS320DM642)

DC_P2 90 90-контактный разъем, на который выведе-
ны сигналы с портов 0 и 1 для приема/пере-
дачи цифровых видеоданных

DC_P3 90 90-контактный разъем, на который выве-
дены сигналы интерфейса EMIF (External 
Memory InterFace, интерфейс для подклю-
чения внешних запоминающих устройств)

P2 124 PCI-разъем
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Таблица П2 
Светодиоды, размещенные на ЛС DM642EVM [2]

Условное 
обозначение  
(см. рисунок)

Цвет  
свечения Назначение

DS1-DS8 Зеленый Задается пользователем при разработке 
конфигурационного файла для ПЛИС

DS9 Желтый Используется для индикации завершения 
процесса конфигурирования ПЛИС

DS10 Зеленый Применяется для индикации состояния 
блокировки у АЦП видеоданных 1 

DS11 Желтый Состояние сброса (RESET)
DS12 Зеленый Используется для индикации того, что на-

пряжение питания подано на ЛС
DS13 Зеленый Применяется для индикации состояния 

блокировки у АЦП видеоданных 2

Сведения о подключении питания  
и перезагрузке ЛС DM642EVM

Подача питания на ЛС DM642EVM осуществляется в следую-
щем порядке:

1)	 разъем «+5 В» блока питания подключается к разъему J10;
2)	 разъем «~220 В» блока питания включается в сеть ~220 В.

Существует три варианта перезагрузки ЛС DM642EVM [2]:
1)	 отключить питание макета вынув кабель из разъема J10;
2)	 нажать на кнопку S3, которая обозначена на печатной плате 

ЛС как «RESET»;
3)	 замкнуть перемычкой переключатель (типа «jumper») JP1, 

который включен параллельно с кнопкой S3.
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